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ИЛИ БИОЛОГИЧЕСКОГО ОРУЖИЯ, ЛЮБУЮ ДЕЯТЕЛЬНОСТЬ В КОНТЕКСТЕ, СВЯЗАННОМ С 
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КАКИМИ-ЛИБО ЯДЕРНЫМИ ВЗРЫВЧАТЫМИ ВЕЩЕСТВАМИ ИЛИ НЕБЕЗОПАСНЫМ ЯДЕРНЫМ 
ТОПЛИВНЫМ ЦИКЛОМ, ИЛИ ДЛЯ СОДЕЙСТВИЯ НАРУШЕНИЯМ ПРАВ ЧЕЛОВЕКА.
ДАННЫЕ О ПРОИЗВОДИТЕЛЬНОСТИ, ПРИВЕДЕННЫЕ В ДАННОМ ДОКУМЕНТЕ, ОСНОВАНЫ 
НА ВНУТРЕННИХ ИССЛЕДОВАНИЯХ И ОЦЕНКЕ КОМПАНИИ HIKROBOT. ФАКТИЧЕСКИЕ 
ДАННЫЕ МОГУТ ОТЛИЧАТЬСЯ В ЗАВИСИМОСТИ ОТ КОНКРЕТНОЙ КОНФИГУРАЦИИ И 
УСЛОВИЙ ЭКСПЛУАТАЦИИ, ПРИЧЕМ КОМПАНИЯ HIKROBOT НЕ НЕСЕТ ОТВЕТСТВЕННОСТИ 
ЗА ВЫТЕКАЮЩИЕ ИЗ ЭТОГО ПОСЛЕДСТВИЯ.
В СЛУЧАЕ ВОЗНИКНОВЕНИЯ КАКИХ-ЛИБО ПРОТИВОРЕЧИЙ МЕЖДУ НАСТОЯЩИМ 
РУКОВОДСТВОМ И ПРИМЕНИМЫМ ЗАКОНОДАТЕЛЬСТВОМ ПРЕИМУЩЕСТВЕННУЮ СИЛУ 
ИМЕЕТ ПОСЛЕДНЕЕ.

Условные обозначения
Символы, которые могут встречаться в этом документе, означают следующее.

Символ Описание

 Опасно
Указывает на опасную ситуацию, которая, если ее не 
предотвратить, приведет или может привести к смерти или 
серьезным травмам.

 Внимание!

Указывает на потенциально опасную ситуацию, которая, 
если ее не предотвратить, может привести к повреждению 
оборудования, потере данных, снижению производительности 
или неожиданным результатам.

 Примечание Предоставляет дополнительную информацию, чтобы подчеркнуть 
или дополнить важные моменты основного текста.

Применимость Руководства
Настоящее Руководство применимо к интеллектуальным считывателям кодов серий ID2000, 
ID3000, ID5000 и IDH5000.

Контактная информация
Hangzhou Hikrobot Co., Ltd.
Адрес электронной почты: tech_support@hikrobotics.com
Веб-сайт: https://en.hikrobotics.com/
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Глава 1. Ethernet/IP

1.1	 Введение
Ethernet/IP  —  это сеть, подходящая для промышленной среды и вариантов применения с 
жесткими временными ограничениями. В Ethernet/IP используются стандартные технологии 
Ethernet, TCP/IP и открытый протокол прикладного уровня CIP, благодаря чему ее можно 
использовать совместно с обычной сетью Ethernet.

 Примечание
В этой главе на примере программируемого логического контроллера (ПЛК) серии Omron NX 
объясняется взаимодействие с интеллектуальным считывателем кода по протоколу Ethernet/
IP. В отношении других устройств следует руководствоваться инструкциями пользователя, 
предоставляемыми производителем, и выполнять соответствующие настройки на основе 
информации, содержащейся в этой главе.

1.2	 Подключение оборудования
Схема подключения ПЛК серии Omron NX и интеллектуального считывателя кода показана 
ниже.

1 

Chapter 1 Ethernet/IP 

1.1 Introduction

Note 

1.2 Hardware Wiring

Omron NX Series PLC Industrial Switch

Smart Code Reader

Figure 1-1 Hardware Wiring 

1.3 Smart Code Reader Settings
code reader’s 

ПЛК серии Omron NX
Промышленный 

коммутатор

Интеллектуальный 
считыватель кода

Рис. 1-1 Подключение оборудования

1.3	 Настройки интеллектуального считывателя кода
Прежде чем использовать функцию Ethernet/IP интеллектуального считывателя кода для 
связи с устройствами ПЛК, необходимо настроить считыватель с помощью программного 
обеспечения IDMVS.
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Прежде чем приступить к настройке:
	y Убедитесь, что на вашем компьютере установлено программное обеспечение IDMVS 

версии V2.3.1 или выше.
	y Проверьте версию прошивки устройства.

Последовательность действий
1.	 Двойным щелчком мыши выберите устройство в списке устройств для его подключения 

к ПО.
2.	 В окне просмотра в режиме реального времени выберите режим работы устройства 

Normal (Обычный).

2 

Before you start: 
● 

● Check the device’s firmware version.

Steps  

Normal

Figure 1-2 Set Device Mode 
Communication Settings
Ethernet/IP Ethernet/IP Enable

Ethernet/IP Input Assembly Size Ethernet/IP Output Assembly Size 

Figure 1-3 Set Parameters 

Note 
Ethernet/IP Input Assembly Size Ethernet/IP Output Assembly 

Size 

Data Processing 

Рис. 1-2 Настройка режима работы устройства
3.	 Перейдите в Communication Settings (Настройки связи) на левой панели навигации.
4.	 Выберите Ethernet/IP в качестве протокола связи и включите Ethernet/IP Enable.
5.	 Задайте параметры Ethernet/IP Input Assembly Size (Размер входного пакета Ethernet/IP) 

и Ethernet/IP Output Assembly (Размер выходного пакета Ethernet/IP) в соответствии с 
задачей.

2 

Before you start: 
● 

● Check the device’s firmware version.

Steps  

Normal

Figure 1-2 Set Device Mode 
Communication Settings
Ethernet/IP Ethernet/IP Enable

Ethernet/IP Input Assembly Size Ethernet/IP Output Assembly Size 

Figure 1-3 Set Parameters 

Note 
Ethernet/IP Input Assembly Size Ethernet/IP Output Assembly 

Size 

Data Processing 

Рис. 1-3 Настройка параметров

 Примечание
По умолчанию для параметров Ethernet/IP Input Assembly Size и Ethernet/IP Output Assembly 
Size используется значение 200.

6.	 Перейдите в раздел Data Processing (Обработка данных) на левой панели навигации и 
задайте формат и содержимое выводимой информации.
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Figure 1-4 Set Data Processing 

Note 
● 
● 

1.4 PLC Settings

1.4.1 Create Sysmac Studio Project 

Steps  
New Project Create

Рис. 1-4 Настройка обработки данных

 Примечание
	y Подробные настройки обработки данных приведены в руководстве пользователя 

интеллектуального считывателя кода.
	y Конкретные параметры могут различаться в зависимости от модели устройства.

1.4	 Настройки ПЛК
В этом разделе в качестве примера настройки используются ПЛК серии Omron NX.

1.4.1	 Создание проекта Sysmac Studio
При работе с ПЛК серии Omron NX необходимо сначала создать проект Sysmac Studio.

Последовательность действий
1.	 Запустите Sysmac Studio, выберите New Project (Создать проект), введите параметры и 

нажмите Create (Создать).
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Figure 1-5 Create New Project 
Global Variables

Figure 1-6 Create Global Variables 

Note 

Controller Setup → Memory Settings Enable 

Рис. 1-5 Создание нового проекта
2.	 Создайте новые глобальные переменные, размер которых должен совпадать с 

соответствующим параметром интеллектуального считывателя кода, настроенным в 
IDMVS.

4 

Figure 1-5 Create New Project 
Global Variables

Figure 1-6 Create Global Variables 

Note 

Controller Setup → Memory Settings Enable 

Рис. 1-6 Создание глобальных переменных

 Примечание
При подключении нескольких интеллектуальных считывателей кода нужно создать 
несколько глобальных переменных с разными именами.

3.	 Перейдите в Controller Setup (Настройки контроллера) → Memory Settings (Настройки 
памяти), установите флажок Enable (Включить) DM и передайте глобальные переменные, 
созданные на шаге 2, в память DM.
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Figure 1-7 Enable DM Area Type 
Controller Setup → Built-in Ethernet/IP Port Settings

Figure 1-8 Set IP Address 

Note 
’s IP address are in the same network 

Tools  Ethernet/IP Connection Settings

Рис. 1-7 Включение типа области DM
4.	 Перейдите в раздел Controller Setup (Настройка контроллера )→ Ethernet/IP Port Settings 

(Настройки встроенного порта Ethernet/IP) и введите IP-адрес порта 1 ПЛК.

5 

Figure 1-7 Enable DM Area Type 
Controller Setup → Built-in Ethernet/IP Port Settings

Figure 1-8 Set IP Address 

Note 
’s IP address are in the same network 

Tools  Ethernet/IP Connection Settings

Рис. 1-8 Ввод IP-адреса

 Примечание
Убедитесь, что IP-адреса ПЛК и интеллектуального считывателя кода находятся в одном 
сегменте сети.

5.	 Нажмите Tools (Сервис) в меню и выберите Ethernet/IP Connection Settings (Настройки 
подключения Ethernet/IP).
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Figure 1-9 Open Ethernet/IP Connection Settings 
Ethernet/IP Device List Registration All 

Figure 1-10 Ethernet/IP Device List 

Figure 1-11 Register Global Variables 
 Target Device Display EDS Library

Install

Рис. 1-9 Как открыть настройки подключения Ethernet/IP
6.	 Дважды щелкните мышью на порте 1 в списке устройств Ethernet/IP Device List и выберите 

Registration All (Регистрация всех) в наборах тегов, чтобы зарегистрировать глобальные 
переменные.

6 

Figure 1-9 Open Ethernet/IP Connection Settings 
Ethernet/IP Device List Registration All 

Figure 1-10 Ethernet/IP Device List 

Figure 1-11 Register Global Variables 
 Target Device Display EDS Library

Install

Рис. 1-10 Список устройств Ethernet/IP

6 

Figure 1-9 Open Ethernet/IP Connection Settings 
Ethernet/IP Device List Registration All 

Figure 1-10 Ethernet/IP Device List 

Figure 1-11 Register Global Variables 
 Target Device Display EDS Library

Install

Рис. 1-11 Регистрация глобальных переменных
7.	 Щелкните правой кнопкой мыши в области Target Device (Целевое устройство), выберите 

Display EDS Library (Показать библиотеку EDS), после чего выберите соответствующий 
файл EDS в библиотеке EDS и нажмите Install (Установить).
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Figure 1-12 Install EDS File 

 Target Device Node address Model name
Revision Add

Built-in Ethernet/IP Port Settings
Consume Data From/Produce Data To Connection I/O Type

 
Figure 1-13 Create Target Device 

Tools → Export Global Variables → Network Configurator…

Рис. 1-12 Установка файла EDS
8.	 Нажмите 

7 

 
Figure 1-12 Install EDS File 

 Target Device Node address Model name
Revision Add

Built-in Ethernet/IP Port Settings
Consume Data From/Produce Data To Connection I/O Type

 
Figure 1-13 Create Target Device 

Tools → Export Global Variables → Network Configurator…

 в области Target Device (Целевое устройство), чтобы добавить устройства, 
введите параметры Node address (Адрес узла), Model name (Название модели) и Revision 
(Версия) в соответствии с задачей и нажмите кнопку Add (Добавить).

9.	 Нажмите 

7 

 
Figure 1-12 Install EDS File 

 Target Device Node address Model name
Revision Add

Built-in Ethernet/IP Port Settings
Consume Data From/Produce Data To Connection I/O Type

 
Figure 1-13 Create Target Device 

Tools → Export Global Variables → Network Configurator…

 в области Built-in Ethernet/IP Port Settings (Настройки встроенного порта 
Ethernet/IP), добавьте созданные целевые устройства, выберите Consume Data From/
Produce Data To (Получать данные из/Создавать данные в) в качестве значения 
параметра Connection I/O Type (Тип ввода-вывода соединения), после чего задайте 
размер и исходную переменную из ранее созданных глобальных переменных.

7 

 
Figure 1-12 Install EDS File 

 Target Device Node address Model name
Revision Add

Built-in Ethernet/IP Port Settings
Consume Data From/Produce Data To Connection I/O Type

 
Figure 1-13 Create Target Device 

Tools → Export Global Variables → Network Configurator…
Рис. 1-13 Создание целевого устройства

10.	Перейдите в меню Tools (Сервис)→ Export Global Variables (Экспорт глобальных 
переменных) → Network Configurator… (Конфигуратор сети...) и экспортируйте глобальные 
переменные.
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Figure 1-14 Export Global Variable File 

1.4.2 Network Configurator Settings 

Steps  
EDS File Install…to import the device’s EDS 

Figure 1-15 Import EDS File 

Рис. 1-14 Экспорт файла глобальных переменных
11.	Сохраните и скомпилируйте проект, а также синхронизируйте его с контроллером ПЛК.

1.4.2	 Настройки сетевого конфигуратора
После создания проекта необходимо настроить его через конфигуратор сети.

Последовательность действий
1.	 Запустите сетевой конфигуратор, щелкните EDS File (Файл ЭЦП) и выберите Install... 

(Установить...), чтобы импортировать файл ЭЦП устройства.

8 

 
Figure 1-14 Export Global Variable File 

1.4.2 Network Configurator Settings 

Steps  
EDS File Install…to import the device’s EDS 

Figure 1-15 Import EDS File 
Рис. 1-15 Импорт файла EDS

2.	 Перетащите соответствующий контроллер ПЛК и интеллектуальный считыватель кода.
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3.	 Чтобы изменить его IP-адрес считывателя щелкните ппо нему правой кнопкой мыши.

9 

Figure 1-16 Modify IP Address 
Tag Sets → To/From File → Import from File

Figure 1-17 Import Global Variables 
’s input/output and the global 

Data In Input_13 Data Out
Output_22 Packet Interval ms

Рис. 1-16 Изменение IP-адреса
4.	 Дважды щелкните на ПЛК, перейдите в Tag Sets (Наборы тегов) → To/From File  

(В/из файла) → Import from File (Импорт из файла) и импортируйте глобальные 
переменные, созданные в Sysmac Studio.

9 

Figure 1-16 Modify IP Address 
Tag Sets → To/From File → Import from File

Figure 1-17 Import Global Variables 
’s input/output and the global 

Data In Input_13 Data Out
Output_22 Packet Interval ms

Рис. 1-17 Импорт глобальных переменных
5.	 Установите связь между входом-выходом интеллектуального считывателя кода и 

глобальными переменными контроллера ПЛК. Данные на входе подключаются к Input_13, 
а данные на выходе подключаются к Output_22. Установите значение параметра Packet 
Interval (Интервал передачи пакетов) 50 мс.
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Figure 1-18 Establish Connection

Note 
is finished, the PLC’s red 

Figure 1-19 Select PLC’s Communication Interface Type 

Рис. 1-18 Установка соединения
6.	 Выберите интерфейс для контроллера ПЛК и загрузите конфигурацию в ПЛК.

 Примечание
После создания соединения между ПЛК и интеллектуальным считывателем кода красный 
индикатор ПЛК NET ERR погаснет.

10 

Figure 1-18 Establish Connection

Note 
is finished, the PLC’s red 

Figure 1-19 Select PLC’s Communication Interface Type Рис. 1-19 Выбор типа коммуникационного интерфейса ПЛК
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Figure 1-20 Connect 

Figure 1-21 Download 

Рис. 1-20 Подключение

11 

 
Figure 1-20 Connect 

Figure 1-21 Download 
Рис. 1-21 Загрузка
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1.5	 Отображение входных и выходных данных

1.5.1	 Сопоставление входных данных
Порядок сопоставления входных данных (интеллектуальный считыватель кода > контроллер 
ПЛК) представлен ниже. 

Таблица 1-1 Таблица сопоставления входных данных

Байт BIT7 BIT6 BIT5 BIT4 BIT3 BIT2 BIT1 BIT0
0-1 Длина полезных данных

2 Decoding Acquiring Trigger Ack Trigger 
Ready

3 General 
Fault

Results NG ResultsOK

4-17 Reserved

18-19 Result Length

20 Result Data 0

...
199 Result Data 179

... Result Data ...

Таблица 1-2 Пояснение к таблице сопоставления входных данных

Название Описание
Trigger Ready Устройство готово к приему нового триггерного сигнала.

Когда задан параметр Trigger Enable и устройство готово к приему 
следующего сигнала триггера, устанавливается состояние готовности к 
триггерованию (Trigger Ready).

Trigger Ack Устройство уже получило сигнал триггера.

Acquiring Устройство получает изображения.

Decoding Устройство распознает расшифровки по изображениям.

Reserved Зарезервировано.

Results OK Устройство успешно выдает новые результаты.
Когда на ПЛК задано Results Ack, он будет очищен.
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Results NG Устройство не считывает коды и не выводит результаты.
Когда на ПЛК задано Results Ack, он будет очищен.

Примечание
Отключите функцию NoRead при использовании сигнала NG.

General Fault Внутренняя неисправность устройства. Этот сигнал можно устранить с 
помощью команды Clear Error (Устранить ошибку).

Result Length Недопустимая длина данных в области результатов.

Данные 
результата

Результат считывания устройства в формате ASCII.
	y Если длина данных результата меньше, чем настроенный модуль 

результата, оставшиеся данные заполняются нулевым значением.
	y Когда длина данных результата превышает заданный размер 

модуля результатов, лишние данные отсекаются.

1.5.2 Сопоставление выходных данных
Порядок сопоставления выходных данных (контроллер ПЛК > интеллектуальный 
считыватель кода) представлен ниже.

Таблица 1-3 Таблица сопоставления выходных данных

Байт BIT7 BIT6 BIT5 BIT4 BIT3 BIT2 BIT1 BIT0

0 Результаты
Ack

Trigger Trigger Enable

1 Clear 
Error

Execute 
Command

2-17 Reserved

18-19 User Data Length

20 User Data 0

...

199 User Data 179

... User Data ...
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Таблица 1-4 Пояснение к таблице сопоставления выходных данных

Название Описание
Trigger Enable С помощью этого бита ПЛК управляет функцией включения 

устройства по триггеру

Триггер При выполнении следующих условий ПЛК устанавливает этот бит 
для запуска устройства для получения изображения и однократного 
запуска алгоритма.

	y Задано Trigger Enable.
	y В настоящее время устройство не получает изображения и не 

запускает алгоритмы.
	y Задано Trigger Ready.

Results Ack 
(Подтверждение 
результатов)

После того, как ПЛК получит последние результаты, задается Result 
Ack. При этом Results OK и Results NG будут стерты.

Reserved Зарезервировано.

Clear Error Состояние устранения ошибки.

1.6	 Проверка триггера

Схема последовательности передачи данных
Схема последовательности передачи данных между ПЛК и устройством показана ниже.

14 

Table 1-4 Output Mapping Table Description 

1.6 Trigger Test

Communication Sequence Diagram 

Figure 1-22 Communication Sequence Diagram 

Name Description 

controls the device’s trigger enable function via this 

● 
● 

● 

Рис. 1-22 Схема последовательности передачи данных
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Логика приведенной выше схемы последовательности передачи данных показана ниже:
1.	 ПЛК устанавливает триггер включения передачи данных сигнала[0].0. После того как 

устройство будет готово, установите сигнал готовности триггера DataIn[2].0.
2.	 Обнаружив сигнал готовности устройства к триггеру, ПЛК посылает сигнал триггера 

DataOut[0].1 и управляет единичным срабатыванием устройства.
3.	 Получив триггерный сигнал устройство начинает получать изображения и запускает 

алгоритм считывания.
	y Если коды считаны успешно, подается сигнал Results OK DataIn[3].0; содержимое кода 

помещается в адрес, начиная с DataIn [20].
	y Если считывание кодов не прошло, подается сигнал Results NG DataIn[3].1; данные 

очищаются, начиная с адреса DataIn [20].

 Примечание
	y Если при включенном NoRead коды не считываются успешно, возвращается значение 

Results OK + символ NoRead.
	y Если коды не считываются успешно, когда NoRead отключен, возвращается значение 

Results NG.

4.	 После обнаружения сигнала Results OK/NG ПЛК начинает считывать результаты из DataIn 
[20].

5.	 После завершения чтения результатов подается сигнал Results Ack DataOut[0].2 и 
отправляется уведомление устройству.

6.	 После завершения процесса триггера ПЛК снова посылает сигнал триггера, и начинается 
следующий цикл процесса триггера.

 Примечание
Если после получения сигнала триггера интеллектуальный считыватель кода не может 
вывести результаты из-за внутренней ошибки (например, после подключения считывателя 
кода к IDMVS не включается получение изображений), будет подан сигнал General Fault 
DataIn[3].7. После того, как ПЛК подтвердит причину ошибки, подается сигнал Clear Error 
DataOut[1].7. Операция триггера может быть продолжена после устранения ошибки.
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Создание переменных
Переменные создаются в соответствии с областью сопоставления ввода/вывода устройства.

16 

Create Variables 
Create variables in accordance with the device’s input/output mapping area.

Figure 1-23 Create Variables 

Ladder Diagram 

● 

Figure 1-24 Enable Trigger 
● 

Figure 1-25 Send Trigger Signal 
● 

Figure 1-26 Clear Trigger Signal 
● 

Рис. 1-23 Создание переменных

Лестничная логическая схема
ПЛК запускает считывание кодов. Соответствующие лестничные логические схемы 
показаны ниже.

	y Включение триггера (Enable Trigger)

16 

Create Variables 
Create variables in accordance with the device’s input/output mapping area.

Figure 1-23 Create Variables 

Ladder Diagram 

● 

Figure 1-24 Enable Trigger 
● 

Figure 1-25 Send Trigger Signal 
● 

Figure 1-26 Clear Trigger Signal 
● 

Рис. 1-24 Включение триггера
	y Отправка триггерного сигнала

Сигнал триггера может быть сформирован путем добавления фронтального сигнала 
перед Trigger Ready в соответствии с задачей. Например, когда ПЛК обнаруживает 
фотоэлектрический входной сигнал, сигнал триггера отправляется один раз.

16 

Create Variables 
Create variables in accordance with the device’s input/output mapping area.

Figure 1-23 Create Variables 

Ladder Diagram 

● 

Figure 1-24 Enable Trigger 
● 

Figure 1-25 Send Trigger Signal 
● 

Figure 1-26 Clear Trigger Signal 
● 

Рис. 1-25 Отправка триггерного сигнала
	y Очистка сигнала триггера

16 

Create Variables 
Create variables in accordance with the device’s input/output mapping area.

Figure 1-23 Create Variables 

Ladder Diagram 

● 

Figure 1-24 Enable Trigger 
● 

Figure 1-25 Send Trigger Signal 
● 

Figure 1-26 Clear Trigger Signal 
● 

Рис. 1-26 Очистка сигнала триггера
	y Получение результатов с устройства
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Когда устройство передает сигнал Results OK или Results NG, это означает, что данные 
результатов были обновлены, и ПЛК может считать их в область хранения пользователя. 
После завершения чтения подается сигнал Results Ack, чтобы сообщить устройству о том, 
что ПЛК закончил чтение данных результатов.

17 

Figure 1-27 Get Device Results 

Note 

● 

 

Figure 1-28 Clear Error 

View Results 

Рис. 1-27 Получение результатов с устройства

 Примечание
Если порядок байтов считанных кодов отличается от фактического, можно включить 
функцию перестановки байтов результатов в программе IDMVS.

	y Clear Error

17 

Figure 1-27 Get Device Results 

Note 

● 

 

Figure 1-28 Clear Error 

View Results 

Рис. 1-28 Очистка ошибки

Просмотр результатов
Откройте окно мониторинга переменных Sysmac Studio и добавьте созданные входную 
переменную DataIn и выходную переменную DataOut. Текущее значение переменной 
соответствует внутреннему входному/выходному значению устройства.
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Figure 1-29 View ResultsРис. 1-29 Просмотр результатов
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Глава 2. Profinet

2.1	 Введение
Profinet  —  это открытый промышленный стандарт EtherNet, разработанный PI для целей 
автоматизации. Profinet использует стандарты TCP/IP и IT-технологий. Он представляет 
собой промышленный Ethernet реального времени, который не только поддерживает 
стандартный протокол TCP/IP, но также обеспечивает временную точность, недостижимую 
для стандартного EtherNet.

 Примечание
В этой главе на примере ПЛК серии Siemens S7 объясняется взаимодействие с 
интеллектуальными считывателями кода по протоколу связи Profinet. В отношении других 
устройств следует руководствоваться инструкциями пользователя, предоставляемыми 
производителем, и выполнять соответствующие настройки на основе информации, 
содержащейся в этой главе.

2.2	 Подключение оборудования
Схема подключения ПЛК серии Siemens S7 и интеллектуального считывателя кодов 
представлена ниже.
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Chapter 2 Profinet 

2.1 Introduction

Note 

2.2 Hardware Wiring

Industrial Switch

Smart Code Reader

Siemens S7 Series PLC

Figure 2-1 Hardware Wiring 

2.3 Smart Code Reader Settings
’s 

 

ПЛК серии Siemens S7
Промышленный 

коммутатор

Интеллектуальный 
считыватель кода

Рис. 2-1 Подключение оборудования

2.3	 Настройки интеллектуального считывателя кода
Прежде чем использовать функцию Profinet интеллектуального считывателя кода для 
связи с другими устройствами, необходимо настроить считыватель с помощью клиентского 
программного обеспечения IDMVS.
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Прежде чем приступить к настройке:
	y Убедитесь, что на вашем компьютере установлено программное обеспечение IDMVS 

версии V2.3.1 или выше.
	y Проверьте версию прошивки устройства.

Последовательность действий
1.	 Двойным щелчком мыши выберите устройство в списке устройств для его подключения 

к ПО.
2.	 В окне просмотра в режиме реального времени выберите режим работы устройства 

Normal (Обычный).

20 

Before you start: 
● 

● Check the device’s firmware version.

Steps  

Normal

Figure 2-2 Set Device Mode 
Communication Settings
Profinet Profinet Enable

Profinet Device Name

Note 

Profinet Result Module Size Profinet Result Timeout

Note 
Profinet Result Module Size 

Figure 2-3 Set Communication Parameters 

Рис. 2-2 Настройка режима работы устройства
3.	 Перейдите в Communication Settings (Настройки связи) на левой панели навигации.
4.	 Выберите Profinet в качестве протокола связи и включите Profinet Enable.
5.	 Введите название устройства Profinet в соответствии с задачей.

 Примечание
Имя устройства должно быть уникальным.

6.	 Задайте значения параметров Profinet Result Module Size (Размер модуля результатов 
Profinet) и Profinet Result Timeout (Время ожидания результатов Profinet) в соответствии 
с задачей.

 Примечание
По умолчанию для параметра Profinet Result Module Size (Размер модуля результатов 
Profinet) используется значение 64 байт.

20 

Before you start: 
● 

● Check the device’s firmware version.

Steps  

Normal

Figure 2-2 Set Device Mode 
Communication Settings
Profinet Profinet Enable

Profinet Device Name

Note 

Profinet Result Module Size Profinet Result Timeout

Note 
Profinet Result Module Size 

Figure 2-3 Set Communication Parameters Рис. 2-3 Настройка параметров связи
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7.	 Перейдите в раздел Data Processing (Обработка данных) на левой панели навигации и 
задайте формат и содержимое выводимой информации.

21 

Data Processing 

 
Figure 2-4 Set Data Processing 

Note 
● 
● 

2.4 PLC Settings

Steps  
Create new project Create

Рис. 2-4 Настройка обработки данных

 Примечание
	y Подробные настройки обработки данных приведены в руководстве пользователя 

интеллектуального считывателя кода.
	y Конкретные параметры могут различаться в зависимости от модели устройства.

2.4	 Настройки ПЛК
В этом разделе в качестве примера настройки ПЛК рассматривается ПЛК серии Siemens S7.

Последовательность действий
1.	 Запустите TIA Portal, нажмите Create new project (Создать новый проект), введите 

параметры и нажмите Create (Создать).
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Figure 2-5 Create New Project 
Options → Manage general station description files (GSD)

Install

Figure 2-6 Install GSDs 
Devices & networks → Hardware category → Other field devices → PROFINET 

IO → Sensors → Hikvision → Machine Vision Systems

Note 

Рис. 2-5 Создание нового проекта
2.	 Перейдите в Options (Настройки) → Manage general station description files (GSD) 

(Управление файлами общего описания станции), импортируйте файлы GSDML на портал 
TIA и нажмите кнопку Install (Установить).

22 

Figure 2-5 Create New Project 
Options → Manage general station description files (GSD)

Install

Figure 2-6 Install GSDs 
Devices & networks → Hardware category → Other field devices → PROFINET 

IO → Sensors → Hikvision → Machine Vision Systems

Note 

Рис. 2-6 Установка GSD
3.	 Перейдите в раздел Devices & networks (Устройства и сети) → Hardware category (Категория 

оборудования) → Other field devices (Другие периферийные устройства) → PROFINET IO 
→ Sensors (Датчики) → Hikvision → Machine Vision Systems (Системы машинного зрения), 
найдите соответствующее устройство, перетащите или дважды щелкните устройство, 
чтобы переместить его в режим просмотра сети.

4.	 Подключите устройство к контроллеру ПЛК.
5.	 Дважды щелкните по устройство, чтобы ввести его имя.

 Примечание
Указанное здесь имя должно совпадать с именем в IDMVS. В противном случае может 
возникнуть ошибка связи.
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6.	 Задайте подсеть, к которой подключен интерфейс, и IP-адрес.

 Примечание
IP-адрес устройства должен отличаться от указанного в IDMVS. В противном случае может 
возникнуть ошибка связи.

7.	 Задайте цикл ввода-вывода устройства и другие параметры.

 Примечание
Увеличьте значение Accepted update cycles without IO data (Допустимые циклы обновления 
без ввода-вывода данных) времени таймера, если устройство переходит в автономный 
режим.

8.	 Перекомпилируйте и загрузите программу ПЛК. Когда ПЛК подключен к устройству, 
индикатор ПЛК и устройства будет постоянно гореть зеленым цветом.

2.5	 Определение модуля устройства
Устройство располагает шестью настраиваемыми модулями (см. ниже):

	y Модуль состояния сбора данных
	y Модуль управления сбором данных
	y Считывает результат модуля размером 64 байта
	y Модуль пользовательских данных размером 64 байта
	y Считывает модуль результата длиной 128 байт
	y Модуля результата считывания размером 250 байт

Модуль состояния сбора данных
Модуль состояния сбора данных отправляет информацию о текущем состоянии устройства 
с устройства на ПЛК.

	y Номер разъема модуля: 1
	y Размер модуля: 1 байт

www.sensotek.ru +7 (495) 181-56-67 info@sensotek.ru



Руководство по эксплуатации промышленного протокола Smart Code Reader

24

Таблица 2-1 Описание модуля состояния сбора данных

Бит Название Описание
0 Trigger Ready Устройство готово к приему нового триггерного сигнала.

Когда задан параметр Trigger Enable и устройство готово 
к приему следующего сигнала триггера, устанавливается 
состояние готовности к триггерованию (Trigger Ready).

1 Trigger Ack Устройство уже получило сигнал триггера.

2 Acquiring Устройство получает изображения.

3 Decoding Устройство распознает расшифровки по изображениям.

4 Results OK Устройство успешно выдает новые результаты.
Когда на ПЛК задано Results Ack, он будет очищен.

5 Results NG Устройство не считывает коды и не выводит результаты.
Когда на ПЛК задано Results Ack, он будет очищен.

 Примечание
Отключите функцию NoRead при использовании сигнала NG.

6 Reserved Зарезервировано.

7 General Fault Выдается внутренняя ошибка.

Модуль управления сбором данных
Модуль управления сбором данных передает изображения с ПЛК на устройство.

	y Номер разъема модуля: 2
	y Размер модуля: 1 байт
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Таблица 2-2 Описание модуля управления сбором данных

Бит Название Описание
0 Trigger Enable С помощью этого бита ПЛК управляет функцией 

включения устройства по триггеру

1 Триггер При выполнении следующих условий ПЛК устанавливает 
этот бит для запуска устройства для получения 
изображения и однократного запуска алгоритма.

	y Задано Trigger Enable.
	y В настоящее время устройство не получает 

изображения и не запускает алгоритмы.
	y Задано Trigger Ready.

2 Results Ack 
(Подтверждение 
результатов)

После того, как ПЛК получит последние результаты, 
задается Result Ack. При этом Results OK и Results NG будут 
стерты.

3 Execute
Command

Выполнение команды, указанной в области 
пользовательских данных.

4-6 Reserved Зарезервировано.

7 Clear Error Состояние устранения ошибки.

Считывает результат модуля размером 64 байта
Происходит считывание результата с модуля размером 64 байта. Результат обработки 
устройства отправляется на ПЛК.

	y Номер разъема модуля: 3, настраиваемый
	y Размер модуля: 65 байт

Таблице 2-3 Описание считывания модуля результата длиной 64 байта

Бит Название Описание
0 Result Length Данные результата содержат фактическую длину данных.

1...64 Данные 
результата

Результат выводится устройством, и его длина составляет 
64 байта.

	y Если длина фактического результата будет меньше 
64 байт, свободные байты будут заполнены нулевым 
значением.

	y Если длина фактического результата превысит 64 
байта, лишние байты будут отсечены.

Модуль пользовательских данных размером 64 байта
В модуле пользовательских данных длиной 64 байта пользовательские данные отправляют-
ся с ПЛК на устройство.

	y Номер разъема модуля: 4, настраиваемый
	y Размер модуля: 65 байт
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Таблица 2-4 Описание модуля пользовательских данных длиной 64 байта

Бит Название Описание

0 User Data Length Пользовательские данные содержат фактическую длину 
данных.

1...64 Данные 
пользователя Данные или команды, отправляемые на устройство.

Считывает модуль результата длиной 128 байт
Модуль считывания результата длиной 128 байт содержит данные результата и отправляется 
устройством в ПЛК.

	y Номер разъема модуля: 3, настраиваемый
	y Размер модуля: 129 байт

Таблица 2-5 Модуль считывания результата длиной 128 байт

Бит Название Описание
0 Result Length Данные результата содержат фактическую длину данных.

1...128 Данные 
результата

Результат выводится устройством, и его длина составляет 
128 байт.

	y Если длина фактического результата будет меньше 
128 байт, свободные байты будут заполнены нулевым 
значением.

	y Если длина фактического результата превысит 128 
байт, лишние байты будут отсечены.

Модуля результата считывания размером 250 байт
Модуль результата считывания длиной 250 байт содержит данные результата считывания и 
отправляется устройством в ПЛК.

	y Номер слота модуля: 3, 5, 6, 7, настраиваемый
	y Размер модуля: 251 байт
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Таблица 2-6 Модуль результата считывания длиной 250 байт

Бит Название Описание
0 Result Length Данные результата содержат фактическую длину данных.

1...250 Данные 
результата

Результат выводится устройством, и его длина составляет 
250 байт.

	y Если длина фактического результата будет меньше 
250 байт, свободные байты будут заполнены нулевым 
значением.

	y Если длина фактического результата превысит 250 
байт, лишние байты будут отсечены.

2.6	 Триггер-тест
Схема последовательности передачи данных
Схема последовательности передачи данных между ПЛК и устройством показана ниже.
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Table 2-6 Reads Result 250 Bytes Module 

Bit Name Description 

1…
● 

● 

2.6 Trigger Test

Communication Sequence Diagram 

Figure 2-7 Communication Sequence Diagram 

2. After detecting the device’s Trigger Ready signal, the PLC sends Trigger signal 

● 

● 

Рис. 2-7 Схема последовательности передачи данных
Логика приведенной выше схемы последовательности передачи данных показана ниже:
1.	 ПЛК подает сигнал включения триггера Q0.0. По мере готовности устройства подается 

сигнал готовности триггера I0.0.
2.	 Обнаружив сигнал готовности устройства к триггеру Trigger Ready, ПЛК посылает сигнал 

триггера Q0.1 и управляет единичным срабатыванием устройства.
3.	 Получив триггерный сигнал устройство начинает получать изображения и запускает 

алгоритм считывания.
	y Если коды считаны успешно, задается сигнал Results I0.4 и вводится содержимое кода в 

адрес, начинающийся с QB2.
	y Если считывание кодов не удалось, подается сигнал Results NG I0.5, а начальный адрес 

QB2 удаляется.
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 Примечание
	y Если при включенном NoRead коды не считываются успешно, возвращается значение 

Results OK + символ NoRead.
	y Если коды не считываются успешно, когда NoRead отключен, возвращается значение 

Results NG.

4.	 После обнаружения результатов OK/NG ПЛК начинает считывать результаты с QB2.
5.	 После завершения считывания результатов подается сигнал подтверждения результатов 

Results Ack Q0.2, и на устройство поступает уведомление.
6.	 После завершения процесса триггера ПЛК снова посылает сигнал триггера, и начинается 

следующий цикл процесса триггера.

 Примечание
Если после получения сигнала триггера интеллектуальный считыватель кода не может 
вывести результаты из-за внутренней ошибки (например, после подключения считывателя 
кода к IDMVS не включается получение изображений), будет подан сигнал General Fault 
I0.7. После того, как ПЛК подтвердит причину ошибки, подается сигнал Clear Error Q0.7, и 
триггерование можно продолжить после устранения ошибки.

Создание переменных
Создание новой переменной ПЛК по адресу, присвоенному устройству в соответствии с его 
конфигурацией. Вы сможете просматривать текущее значение каждого модуля устройства 
в режиме онлайн.
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Note 
● If codes are not read successfully when NoRead is enabled, Results OK + “NoRead” 

● 

Note 

Create Variables 

 
Figure 2-8 Create PLC Variable Рис. 2-8 Создание переменной ПЛК
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Figure 2-9 Overview of Address 

Ladder Diagram 

● 

Figure 2-10 Enable Camera 
● 

Figure 2-11 Send Trigger Signal 
● 

Рис. 2-9 Обзор адреса

Лестничная логическая схема
ПЛК запускает считывание кодов. Соответствующие лестничные логические схемы 
показаны ниже.

	y Включение триггера (Enable Trigger)

29 

 
Figure 2-9 Overview of Address 

Ladder Diagram 

● 

Figure 2-10 Enable Camera 
● 

Figure 2-11 Send Trigger Signal 
● 

Рис. 2-10 Включение камеры
	y Отправка триггерного сигнала

Сигнал триггера может быть сформирован путем добавления фронтального сигнала 
перед Trigger Ready в соответствии с задачей. Например, когда ПЛК обнаруживает 
фотоэлектрический входной сигнал, сигнал триггера отправляется один раз. На рисунке 
ниже показано, что сигнал триггера выводится каждую секунду через внутренние системные 
часы.

29 

 
Figure 2-9 Overview of Address 

Ladder Diagram 

● 

Figure 2-10 Enable Camera 
● 

Figure 2-11 Send Trigger Signal 
● 

Рис. 2-11 Отправка триггерного сигнала
• Очистка сигнала триггера
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Figure 2-12 Clear Trigger Signal 
● 

Figure 2-13 Add Result Data Block 

Рис. 2-12 Очистка сигнала триггера
	y Получение результатов с устройства

Создайте блок данных базы данных для хранения результата считывания, добавьте 
переменную результатов (см. ниже). Первый байт обозначает длину результата. Байты 
хранения результата начинаются со второго байта.
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Figure 2-12 Clear Trigger Signal 
● 

Figure 2-13 Add Result Data Block Рис. 2-13 Добавление блока данных результата
Когда устройство выдает сигнал Results OK или NG, это означает, что данные результата 
были обновлены, и ПЛК считывает данные результата в блок данных базы данных.
После завершения считывания задается сигнал Results Ack, подтверждающий, что устрой-
ство завершило считывание данных результата.
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Figure 2-14 Get Results 
● 

 

Figure 2-15 Clear Error 

View Results 

Рис. 2-14 Получение результатов
	y Clear Error
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Figure 2-14 Get Results 
● 

 

Figure 2-15 Clear Error 

View Results 

Рис. 2-15 Устранение ошибки

Просмотр результатов
На вкладке мониторинга и опций можно отслеживать состояние переменных каждого мо-
дуля устройства и просматривать выводимые результаты. На вкладке Trace (Трассировка) 
можно добавить записи трассировки переменных и просмотреть контрольную последова-
тельность.
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Figure 2-16 View Control Sequence 
Рис. 2-16 Просмотр контрольной последовательности
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Глава 3. ModBus

3.1	 Введение
Modbus — это протокол, работающий по принципу запрос/ответ. Его сервисы определяют-
ся функциональными кодами. Порт 502 зарезервирован для связи по протоколу ModBus.  
В процессе его работы для обмена данными ввода-вывода и диагностической информацией 
используется стандартное аппаратное и программное обеспечение EtherNet.

 Примечание
В этой главе объясняется взаимодействие с интеллектуальными считывателями кода 
по протоколу связи ModBus на примере ПЛК серии Siemens S7. В отношении других 
устройств следует руководствоваться инструкциями пользователя, предоставляемыми 
производителем, и выполнять соответствующие настройки на основе информации, 
содержащейся в этой главе.

3.2	 Подключение оборудования
Ниже показано подключение контроллера ПЛК, утилиты тестирования ModBus TCP и 
интеллектуального считывателя кода.
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Chapter 3 ModBus 

3.1 Introduction

Note 

3.2 Hardware Wiring

PLC Controller

Smart Code Reader

Industrial Switch

ModBus TCP Test Tool

Figure 3-1 Hardware Wiring 

3.3 Smart Code Reader Settings
’s 

Утилита для тестирования 
ModBus TCP

Контроллер ПЛК

Промышленный 
коммутатор

Интеллектуальный 
считыватель кода

Рис. 3-1 Подключение оборудования

3.3	 Настройки интеллектуального считывателя кода
Прежде чем использовать функцию ModBus интеллектуального считывателя кода для 
связи с другими устройствами, необходимо настроить считыватель с помощью клиентского 
программного обеспечения IDMVS.
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Прежде чем приступить к настройке:
	y Убедитесь, что на вашем компьютере установлено программное обеспечение IDMVS 

версии V2.3.1 или выше.
	y Проверьте версию прошивки устройства.

Последовательность действий
1.	 Двойным щелчком мыши выберите устройство в списке устройств для его подключения 

к ПО.
2.	 В окне просмотра в режиме реального времени выберите режим работы устройства 

Normal (Обычный).
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Before you start: 
● 

● Check the device’s 

Steps  

Normal

Figure 3-2 Set Device Mode 
Communication Settings
ModBus ModBus Enable

ModBus Mode Server Client
● 

Рис. 3-2 Настройка режима работы устройства
3.	 Перейдите в Communication Settings (Настройки связи) на левой панели навигации.
4.	 Выберите ModBus в качестве протокола связи и включите ModBus Enable.
5.	 Выберите режим ModBus в качестве сервера или клиента.

	y Если режим ModBus используется в качестве сервера, данные управления, статуса и 
результата находятся в регистре временного хранения. Адрес смещения фиксирован, 
настроить можно только размер модуля результата.
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Figure 3-3 Server Mode 
● You should set the server’s 

Рис. 3-3 Серверный режим работы
	y Необходимо задать IP-адрес сервера (то есть ПЛК или утилиты тестирования ModBus), 

номер порта, а также контрольный интервал опроса (если используется режим клиента 
Modbus). Данные управления, статуса и результата находятся в регистре временного 
хранения. Можно настроить адрес смещения и размер модуля результата.
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Figure 3-4 Client Mode 
Data Processing 

Рис. 3-4 Режим клиента
6. Перейдите в раздел Data Processing (Обработка данных) на левой панели навигации и 
задайте формат и содержание выводимой информации.
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Figure 3-5 Set Data Processing 

Note 
● 
● 

3.4 ModBus TCP Test Tool

● 
● 

3.4.1 ModBus Poll 

Steps  

Рис. 3-5 Настройка обработки данных

 Примечание
	y Подробные настройки обработки данных приведены в руководстве пользователя 

интеллектуального считывателя кода.
	y Конкретные параметры могут различаться в зависимости от модели устройства.

3.4	 Утилита тестирования ModBus TCP
С помощью инструмента тестирования ModBus TCP можно проверить, нормально ли 
работает связь ModBus между устройствами.

	y Когда устройство работает в режиме сервера, можно использовать программное 
обеспечение ModBus Poll.

	y Когда устройство работает в режиме клиента, можно использовать программное 
обеспечение ModBus Slave.

3.4.1	 ModBus Poll
Когда устройство работает в режиме сервера, при этом программное обеспечение ModBus 
Poll работает в режиме клиента и будет активно подключаться к устройству.

Последовательность действий
1.	 Введите параметры настройки подключения в соответствии с задачей.
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Figure 3-6 Set IP Address and Port 

Note 

Figure 3-7 Set Polling and Reading Holding Register 

Рис. 3-6 Установка IP-адреса и порта

 Примечание
Порт сервера задан как 502.

2.	 Считывание регистров хранения устройства осуществляется командой 03, чтение 
начинается с адреса смещения 0, задается соответствующее количество регистров 
чтения и интервал периодического обновления считывания.
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Figure 3-6 Set IP Address and Port 

Note 

Figure 3-7 Set Polling and Reading Holding Register Рис. 3-7 Настройка периодического обновления и считывания регистра хранения данных
3.	 Поочередно запишите 3 и 5 в регистр адреса смещения 0 в области управления, 

чтобы запустить устройство на однократный захват изображения, и верните результат 
считывания кода в область результатов.
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Figure 3-8 Results 

3.4.2 ModBus Slave 

Steps  

2. Set the device’s Server IP and Server

Рис. 3-8 Результаты

3.4.2	 ModBus Slave
Когда устройство работает в режиме клиента, можно использовать программное обеспечение 
ModBus Slave.

Последовательность действий
1.	 Запуск ModBus Slave, который ожидает подключения устройства.
2.	 Настройка IP-адрес сервера устройства и порт сервера
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Figure 3-9 Set Server IP and Port Рис. 3-9 Настройка IP-адреса и порта сервера

3.	 Установите идентификатор ведомого устройства равным 255 и следите за областью 
регистра хранения.

4.	 Используйте команду 03 для последовательного считывания области регистра хранения 
в соответствии с заданным интервалом времени.
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Figure 3-10 Set Slave Definition Parameters 

 

Figure 3-11 Results 

Рис. 3-10 Установка параметров определения ведомого устройства
5.	 Поочередно запишите 3 и 5 в регистр в области управления, чтобы запустить устройство 

на однократный захват изображения, и верните результат считывания кода в область 
результатов.
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Figure 3-10 Set Slave Definition Parameters 

 

Figure 3-11 Results Рис. 3-11 Результаты
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3.5	 Настройки ПЛК
В этом разделе в качестве примера рассматриваются настройки ModBus TCP ПЛК серии 
Siemens S7, чтобы объяснить, как настроить связь ПЛК по ModBus.

Последовательность действий
1.	 Запустите TIA Portal, нажмите Create new project (Создать новый проект), введите 

параметры и нажмите Create (Создать).
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3.5 PLC Settings

PLC’s ModBus communication.

Steps  
Create new project Create

Figure 3-12 Create New Project 

 
Figure 3-13 Add PLC 

Рис. 3-12 Создание нового проекта
2.	 Добавьте соответствующий контроллер ПЛК.
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3.5 PLC Settings

PLC’s ModBus communication.

Steps  
Create new project Create

Figure 3-12 Create New Project 

 
Figure 3-13 Add PLC Рис. 3-13 Добавление ПЛК
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3.	 Установите IP-адрес контроллера ПЛК.

43 

 
Figure 3-14 Set IP Address 

Communication → Others → MODBUS TCP

 
Figure 3-15 MV_ID_REG Data Block 

 
Figure 3-16 MV_MB_TCON Data Block 

Рис. 3-14 Установка IP-адреса
4.	 Перейдите в раздел Связь  Другие  MODBUS TCP и добавьте команду MB_SERVER.
5.	 Создайте новый блок данных MV_ID_REG в контакте MB_HOLD_REG для хранения 

коммуникационных данных регистра хранения и добавьте переменные в этот блок 
данных.

43 

 
Figure 3-14 Set IP Address 

Communication → Others → MODBUS TCP

 
Figure 3-15 MV_ID_REG Data Block 

 
Figure 3-16 MV_MB_TCON Data Block 

Рис. 3-15 Блок данных MV_ID_REG
6.	 Создайте новый блок данных MV_MB_TCON в контакте CONNECT, создайте переменную 

MV_MB_Server, назначьте ее тип данных как TCON_IP_v4 и разверните переменные, чтобы 
присвоить ей значения.

43 

 
Figure 3-14 Set IP Address 

Communication → Others → MODBUS TCP

 
Figure 3-15 MV_ID_REG Data Block 

 
Figure 3-16 MV_MB_TCON Data Block 

Рис. 3-16 Блок данных MV_MB_TCON
7.	 Сохраните другие контакты по адресу, начинающемуся с M10.0.
8.	 Скомпилируйте проект и загрузите его на контроллер ПЛК.
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3.6	 Определение регистра устройства
Устройство использует только регистры хранения и разделено на три области: управление, 
состояние и результат.

Управление
Область управления управляет устройством для передачи изображений с ПЛК на устройство.

	y Расположение области управления: регистр хранения, настраиваемое смещение  
(по умолчанию 0).

	y Размер области управления: 1 регистр (2 байта).

Таблица 3-1 Определение области управления

REG/бит Название Описание
REG0.0 Trigger Enable С помощью этого бита ПЛК управляет функцией 

включения устройства по триггеру

REG0.1 Триггер При выполнении следующих условий ПЛК 
устанавливает этот бит для запуска устройства для 
получения изображения и однократного запуска 
алгоритма.

	y Задано Trigger Enable.
	y В настоящее время устройство не получает 

изображения и не запускает алгоритмы.
	y Задано Trigger Ready.

REG0.2 Results Ack 
(Подтверждение 
результатов)

После того, как ПЛК получит последние результаты, 
задается Result Ack. При этом Results OK и Results NG 
будут стерты.

REG0.3-14 Reserved Зарезервировано.

REG0.15 Clear Error Состояние устранения ошибки.

Состояние
Область состояния возвращает текущее состояние устройства с устройства на ПЛК.

	y Расположение области состояния: регистр хранения, настраиваемое смещение 
 (по умолчанию 1).

	y Размер области состояния: 1 регистр (2 байта).
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Таблица 3-2 Определение области состояния

REG1/бит Название Описание
REG1.0 Trigger Ready Устройство готово к приему нового триггерного сигнала.

Когда задан параметр Trigger Enable и устройство готово 
к приему следующего сигнала триггера, устанавливается 
состояние готовности к триггерованию (Trigger Ready).

REG 1.1 Trigger Ack Устройство уже получило сигнал триггера.

REG 1.2 Acquiring Устройство получает изображения.

REG 1.3 Decoding Устройство распознает расшифровки по изображениям.

REG 1.4-7 Reserved Зарезервировано.

REG 1.8 Results OK Устройство успешно выдает новые результаты.
Когда на ПЛК задано Results Ack, он будет очищен.

REG 1.9 Results NG Устройство не считывает коды и не выводит результаты.
Когда на ПЛК задано Results Ack, он будет очищен.

 Примечание
Отключите функцию NoRead при использовании сигнала 
NG.

REG 1.10-14 Reserved Зарезервировано.

REG 1.15 General Fault Внутренняя неисправность устройства. Этот сигнал 
можно устранить с помощью команды Clear Error 
(Устранить ошибку).

Результат
В области результатов хранятся данные о результатах, передаваемые с устройства на ПЛК.

	y Расположение области результатов: регистр хранения, настраиваемое смещение (по 
умолчанию 2).

	y Размер результата: от 4 до 500 регистров (по умолчанию 100).
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Таблица 3-3 Определение области результатов

REG/слово Название Описание

REG2 Result Length Область результатов содержит недопустимую длину 
данных.

REG3 Данные 
результата

Результат, выданный устройством.
	y Если длина данных результата меньше, чем 

сконфигурированный модуль результатов, 
свободные байты будут заполнены значением 0.

	y Если длина данных результата больше, чем 
сконфигурированный модуль результатов, лишние 
байты будут обрезаны.

3.7	 Триггер-тест

Схема последовательности передачи данных
Схема последовательности передачи данных между ПЛК и устройством показана ниже.
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Table 3-3 Result Area Definition 

REG/word Name Description 

REG3…
● 

● 

3.7 Trigger Test

Communication Sequence Diagram 

Figure 3-17 Communication Sequence Diagram 

2. After detecting the device’s Trigger Ready signal, the PLC sends Trigger signal 

● 

Рис. 3-17 Схема последовательности передачи данных
Логика приведенной выше схемы последовательности передачи данных показана ниже:
1.	 ПЛК задает сигнал Trigger Enable REG0.0. После того, как устройство будет готово, 

задается сигнал Trigger Ready REG1.0.
2.	 После обнаружения сигнала Trigger Ready устройства ПЛК посылает сигнал триггера 

REG0.1 и управляет устройством для считывания кодов.
3.	 Устройство начинает получать изображения и расшифровывать их после получения 

сигнала триггера.
	y Если коды считаны успешно, задается сигнал Results OK REG1.8 и вводится длина кода и 

его содержимое в адрес, начинающийся с REG2.
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	y Если считывание кодов не удалось, задается сигнал Results NG REG1.9 и очищается 
начальный адрес REG2.

 Примечание
	y Если при включенном NoRead коды не считываются успешно, возвращается значение 

Results OK + символ NoRead.
	y Если коды не считываются успешно, когда NoRead отключен, возвращается значение 

Results NG.

4.	 После обнаружения Results OK/NG ПЛК начинает считывать длину кода и данные из 
REG2.

5.	 После завершения считывания результатов подается сигнал подтверждения результатов 
Results Ack REG0.2, и на устройство поступает уведомление.

6.	 После завершения процесса триггера ПЛК снова посылает сигнал триггера, и начинается 
следующий цикл процесса триггера.

 Примечание
Если после получения сигнала триггера интеллектуальный считыватель кода не может 
вывести результаты из-за внутренней ошибки (например, после подключения считывателя 
кода к IDMVS не включается получение изображений), будет подан сигнал General Fault 
REG1.15. После того, как ПЛК подтвердит причину ошибки, подается сигнал Clear Error 
REG0.15, и операция триггера может быть продолжена после устранения ошибки.

Создание переменных
Создайте переменные в соответствии с регистром устройства.
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● 

Note 
● If codes are not read successfully when NoRead is enabled, Results OK + “NoRead” 

● 

Note 

Create Variables 
cordance with the device’s register.

 
Figure 3-18 Create Variables 

Ladder Diagram 

● 

Рис. 3-18 Создание переменных

Лестничная логическая схема
ПЛК запускает считывание кодов. Соответствующие лестничные логические схемы 
показаны ниже.

	y Отправка состояния управления и считывания
Запись MW100 в область управления устройства, считывание области состояния устройства 
в MW102 и создание переменных для каждого бита управления и состояния.
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Figure 3-19 Send Control and Reading Status 
● 

Figure 3-20 Enable Trigger 
● 

Рис. 3-19 Отправка состояния управления и считывания
	y Включение триггера (Enable Trigger)
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Figure 3-19 Send Control and Reading Status 
● 

Figure 3-20 Enable Trigger 
● 

Рис. 3-20 Включение с триггера (Enable Trigger)
	y Триггерование устройства для считывания кодов

Сигнал триггера может быть сформирован путем добавления фронтального сигнала 
перед Trigger Ready в соответствии с задачей. Например, когда ПЛК обнаруживает 
фотоэлектрический входной сигнал, сигнал триггера отправляется один раз. На рисунке 
ниже показано, что сигнал триггера выводится каждую секунду через внутренние системные 
часы.
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Figure 3-21 Send Trigger Signal 
● 

Figure 3-22 Clear Trigger Signal 
● 

Figure 3-23 Add Result Array Variable 

Note 

Рис. 3-21 Отправка сигнала триггера
	y Очистка сигнала триггера
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Figure 3-21 Send Trigger Signal 
● 

Figure 3-22 Clear Trigger Signal 
● 

Figure 3-23 Add Result Array Variable 

Note 

Рис. 3-22 Сигнал Clear Trigger
	y Получение результатов с устройства

Создайте блок данных базы данных для хранения результата считывания, добавьте 
переменную массива результатов, как показано ниже.
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Figure 3-21 Send Trigger Signal 
● 

Figure 3-22 Clear Trigger Signal 
● 

Figure 3-23 Add Result Array Variable 

Note 

Рис. 3-23 Добавление переменной массива результатов
Когда устройство выдает сигнал Results OK или NG, это означает, что данные результата 
были обновлены, и ПЛК считывает данные результата в блок данных базы данных.
После завершения считывания задается сигнал Results Ack, подтверждающий, что устройство 
завершило считывание данных результата.

 Примечание
Если порядок следования считываемых кодов отличается от фактического, вы можете 
включить функцию перестановки байтов результата с помощью IDMVS.
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Figure 3-24 Get Device Results 
● 

 
Figure 3-25 Clear Error 

View Results 

Рис. 3-24 Получение результатов с устройства
	y Clear Error
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Figure 3-24 Get Device Results 
● 

 
Figure 3-25 Clear Error 

View Results 

Рис. 3-25 Clear Error (Устранение ошибки)

Просмотр результатов
На вкладке мониторинга и опций можно отслеживать состояние переменных каждого 
модуля устройства и просматривать выводимые результаты. Вы также можете добавить 
записи отслеживания переменных на вкладке Trace, чтобы просмотреть последовательность 
операций управления.
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Figure 3-26 View Results 

 
Figure 3-27 View Control Sequence 

  

Рис. 3-26 Просмотр результатов
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Figure 3-26 View Results 

 
Figure 3-27 View Control Sequence 

  
Рис. 3-27 Просмотр последовательности управления
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Глава 4   MELSEC/SLMP

4.1	 Введение
MELSEC/SLMP - это аббревиатура коммуникационного протокола считывания или записи 
данных с устройства центрального процессора программируемых контроллеров серии Q/L 
внешними устройствами через модуль C24 или E71.

 Примечание
В этой главе в качестве примера рассматриваются ПЛК Mitsubishi серии Q и серии FX3U, 
для того чтобы показать, как взаимодействовать с интеллектуальным считывателем кода 
по протоколу связи MELSEC/SLMP. В случае других устройств обратитесь к руководству 
пользователя, предоставленному производителем, и выполните соответствующие 
настройки, ознакомившись с содержанием этой главы.	

4.2	 Подключение оборудования
Схема подключения ПЛК Mitsubishi и интеллектуального считывателя кода показана ниже.
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Chapter 4 MELSEC/SLMP 

4.1 Introduction

Note 

4.2 Hardware Wiring

Mitsubishi Q Series PLC

Industrial Switch

Smart Code Reader

Mitsubishi FX3U Series PLC

Figure 4-1 Hardware Wiring 

ПЛК серии Mitsubishi Q

ПЛК серии Mitsubishi FX3U

Промышленный коммутатор

Интеллектуальный 
считыватель кода

Рис. 4-1 Подключение оборудования
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4.3	 Настройки интеллектуального считывателя кода
Прежде чем использовать функцию MELSEC/SLMP интеллектуального считывателя кода 
для связи с другими устройствами, необходимо сначала настроить считыватель с помощью 
программного обеспечения IDMVS.

Прежде чем приступить к настройке:
	y Убедитесь, что на вашем компьютере установлено программное обеспечение IDMVS 

версии V2.3.1 или выше.
	y Проверьте версию прошивки устройства.

Последовательность действий
1.	 Двойным щелчком мыши выберите устройство в списке устройств для его подключения 

к ПО.
2.	 В окне просмотра в режиме реального времени выберите режим работы устройства 

Normal (Обычный).
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4.3 Smart Code Reader Settings
Before using the smart code reader’s 

Before you start: 
● 

● Check the device’s firm

Steps  

Normal

Figure 4-2 Set Device Mode 
Communication Settings
MELSEC/SLMP MELSEC/SLMP Enable

MELSEC Server IP MELSEC Server Port
MELSEC Frame Type

● MELSEC Frame Type 
● MELSEC Frame Type 

MELSEC Control Poll Interval 

Note 
● 

● 

Рис. 4-2 Настройка режима работы устройства

3.	 Перейдите в Communication Settings (Настройки связи) на левой панели навигации.
4.	 Выберите MELSEC/SLMP в качестве протокола связи и включите MELSEC/SLMP Enable.
5.	 Введите IP-адрес сервера MELSEC и порт сервера MELSEC в соответствии с задачей.
6.	 Установите MELSEC Frame Type.

	y Для ПЛК Mitsubishi серии Q следует задать для MELSEC Frame Type значения 1E, 3E или 
4E.

	y Для ПЛК Mitsubishi серии FX3U следует задать для MELSEC Frame Type значение 1E.
7.	 Установите интервал MELSEC Control Poll Interval в соответствии с задачей.

 Примечание
	y Чем меньше настроенный интервал, тем чаще выполняется считывание и тем больше 

нагрузка на сеть.
	y Модули управления, состояния и результатов расположены в области D устройства. 

Адрес смещения и размер результирующего модуля можно настроить.
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Figure 4-3 Set Parameters 
Data Processing 

Figure 4-4 Set Data Processing 

Рис. 4-3 Установка параметров
8.	 Перейдите в раздел Data Processing (Обработка данных) на левой панели навигации и 

задайте формат и содержимое выводимой информации.
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Figure 4-3 Set Parameters 
Data Processing 

Figure 4-4 Set Data Processing Рис. 4-4 Настройка обработки данных
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 Примечание
	y Подробные настройки обработки данных приведены в руководстве пользователя 

интеллектуального считывателя кода.
	y Конкретные параметры могут различаться в зависимости от модели устройства.

4.4	 Настройки ПЛК
В этом разделе в качестве примера настройки ПЛК рассматриваются ПЛК Mitsubishi серий 
FX3U и Q.

4.4.1	 ПЛК серии Mitsubishi FX3U
ПЛК Mitsubishi серии FX3U использует внешний модуль Ethernet для реализации функции связи 
MELSEC/SLMP. Перед использованием необходимо выполнить настройку оборудования. 
Используйте инструмент настройки FX3U-ENET-L, чтобы задать IP-адрес модуля Ethernet и 
включить функцию связи MC.

Конфигурация модуля Ethernet

Последовательность действий
1.	 Запустите конфигуратор FX3U-ENET-L и выберите модуль 0.
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Note 
● 
● 

4.4 PLC Settings

4.4.1 Mitsubishi FX3U Series PLC 

Ethernet Module Configuration 

Steps  

 
Figure 4-5 Ethernet Module Settings 

● Binary code

Рис. 4-5 Настройки модуля Ethernet
2.	 Настройте рабочие параметры.

	y Код данных связи: На устройстве нужно задать BIN_1 frame, если выбран двоичный код, 
или ASCII_1E frame, если выбран ASCII-код.
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	y Начальное время: Выберите Всегда ждать ОТКРЫТИЯ.
	y IP-адрес: Он должен совпадать с IP-адресом сервера устройства.
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ASCII code
● Always wait for OPEN
● IP address: It should be the same with the device’s Server IP address.

 
Figure 4-6 Ethernet Operational Settings 

TCP Protocol Passive (MC) Open system
5000 host station Port No. (DEC.)

Create GX-Works2 Project 

Steps  
Series Type

Navigation → Connection Destination → PC Side I/F Serial Setting → Serial 
USB

Note 

Рис. 4-6 Рабочие настройки Ethernet
3.	 Откройте настройки Ethernet, установите TCP в качестве протокола, Passive (MC) в 

качестве системы для открытия и 5000 в качестве номера порта хост-станции (DEC.).
4.	 Запись в ПЛК после настройки.

Создание проекта GX-Works2
При использовании ПЛК Mitsubishi серии FX3U также следует создать проект GX-Works2.

Последовательность действий
1.	 Создайте новый проект GX-Works2, установите серию и тип в соответствии с ПЛК серии 

FX3U.
2.	 Перейдите в Navigation → Connection Destination → PC Side I/F Serial Setting → Serial USB 

и установите COM-порт и скорость передачи.

 Примечание
Убедитесь, что к ПЛК можно подключиться к последовательному порту через кабель USB.
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4.4.2	 ПЛК Mitsubishi серии Q
ПЛК Mitsubishi серии Q можно настроить с помощью GX-Works2.

Последовательность действий
1.	 Создайте новый проект GX-Works2, задайте серию и тип в соответствии с ПЛК серии Q.
2.	 Перейдите в Navigation → Connection Destination → PC Side I/F, выберите шину для серии 

Q и выберите Ethernet для теста коммуникационного соединения.

 Примечание
Убедитесь, что к ПЛК можно подключиться по сети.

3.	 Перейдите в Navigation → Project → Parameters → PLC Parameters → Built-in Ethernet Port, 
установите IP-адрес ПЛК, который должен совпадать с IP-адресом сервера устройства.

4.	 Код данных связи: На устройстве нужно задать BIN_1 frame, если выбран двоичный код, 
или ASCII_1E frame, если выбран ASCII-код.

5.	 Установите флажок Включить онлайн-изменение (FTP, протокол MC).
6.	 Нажмите Открыть настройки, включите протокол MC, установите протокол TCP и порт, 

которые должны совпадать с адресом порта сервера устройства.

4.5	 Определение модуля устройства
Устройство состоит из трех модулей: управление, состояние и результат.

Управление
Модуль управления управляет устройством для передачи изображений с ПЛК на устройство.

	y Расположение модуля управления: область программного компонента D, настраиваемое 
смещение (по умолчанию 0).

	y Размер модуля управления: 2 байта.
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Таблица 4-1 Определение модуля управления

D0/бит Название Описание
D0.0 Trigger Enable С помощью этого бита ПЛК управляет функцией включения 

устройства по триггеру

D0.1 Триггер При выполнении следующих условий ПЛК устанавливает 
этот бит для запуска устройства для получения изображения 
и однократного запуска алгоритма.

	y Задано Trigger Enable.
	y В настоящее время устройство не получает изображения 

и не запускает алгоритмы.
	y Задано Trigger Ready.

D0.2 Results Ack 
(Подтверждение 
результатов)

После того, как ПЛК получит последние результаты, 
задается Result Ack. При этом Results OK и Results NG будут 
стерты.

D0.3-14 Reserved Зарезервировано.

D0.15 Clear Error Состояние устранения ошибки.

Состояние
Модуль состояния возвращает текущее состояние устройства с устройства на ПЛК.

	y Расположение модуля состояния: область программного компонента D, настраиваемое 
смещение (по умолчанию 1).

	y Размер модуля состояния: 2 байта.
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Таблица 4-2 Определение модуля состояния

D1/бит Название Описание
D1.0 Trigger Ready Устройство готово к приему нового триггерного сигнала.

Когда задан параметр Trigger Enable и устройство готово 
к приему следующего сигнала триггера, устанавливается 
состояние готовности к триггерованию (Trigger Ready).

D1.1 Trigger Ack Устройство уже получило сигнал триггера.

D1.2 Acquiring Устройство получает изображения.

D1.3 Decoding Устройство распознает расшифровки по изображениям.

D1.4-7 Reserved Зарезервировано.

D1.8 Results OK Устройство успешно выдает новые результаты.
Когда на ПЛК задано Results Ack, он будет очищен.

D1.9 Results NG Устройство не считывает коды и не выводит результаты.
Когда на ПЛК задано Results Ack, он будет очищен.

 Примечание
Отключите функцию NoRead при использовании сигнала NG.

D1.10-
14

Reserved Зарезервировано.

D1.15 General Fault Внутренняя неисправность устройства. Этот сигнал можно 
устранить с помощью команды Clear Error (Устранить ошибку).

Результат
Модуль результата сохраняет данные результата с устройства в ПЛК.

	y Расположение модуля результата: область программного компонента D, настраиваемое 
смещение (по умолчанию 2).

	y Размер результата: от 2 до 500 слов (по умолчанию 100).
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Таблица 4-3 Определение модуля результата

Слово Название Описание
D2 Результат

Длина
Область результатов содержит недопустимую длину данных.

D3... Данные 
результата

Результат, выданный устройством.
	y Если длина данных результата меньше, чем 

сконфигурированный модуль результатов, свободные байты 
будут заполнены значением 0.

	y Если длина данных результата больше, чем 
сконфигурированный модуль результатов, лишние байты 
будут обрезаны.

4.6	 Триггер-тест

Схема последовательности передачи данных
Схема последовательности передачи данных между ПЛК и устройством показана ниже.
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Table 4-3 Result Module Definition 

Word Name Description 

3…
● 

● 

4.6 Trigger Test

Communication Sequence Diagram 

Figure 4-7 Communication Sequence Diagram 

2. After detecting the device’s Trigger Ready signal, 

● 

Рис. 4-7 Схема последовательности передачи данных
Логика приведенной выше схемы последовательности передачи данных показана ниже:
1.	 ПЛК устанавливает сигнал Trigger Enable D0.0. После того, как устройство будет готово, 

задается сигнал Trigger Ready D1.0.
2.	 После обнаружения сигнала устройства Trigger Ready ПЛК посылает сигнал триггера D0.1 

и управляет устройством для считывания кодов.
3.	 Устройство начинает получать изображения и расшифровывать их после получения 

сигнала триггера.
	y Если коды считаны успешно, задается сигнал Results OK D1.8 и вводится длина кода и его 

содержимое в адрес, начинающийся с D2.
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	y Если считывание кодов не удалось, задается сигнал Results NG D1.9 и очищается 
начальный адрес D2.

 Примечание
	y Если при включенном NoRead коды не считываются успешно, возвращается значение 

Results OK + символ NoRead.
	y Если коды не считываются успешно, когда NoRead отключен, возвращается значение 

Results NG.

4.	 После обнаружения Results OK/NG ПЛК начинает считывать длину кода и данные из D2.
5.	 После завершения считывания результатов подается сигнал подтверждения результатов 

Results Ack D0.2, и на устройство поступает уведомление.
6.	 После завершения процесса триггера ПЛК снова посылает сигнал триггера, и начинается 

следующий цикл процесса триггера.

 Примечание
Если после получения сигнала триггера интеллектуальный считыватель кода не может 
вывести результаты из-за внутренней ошибки (например, после подключения считывателя 
кода к IDMVS не включается получение изображений), будет подан сигнал General Fault 
D1.15. После того, как ПЛК подтвердит причину ошибки, подается сигнал Clear Error D0.15, и 
операция запуска может быть продолжена после устранения ошибки.

Лестничная логическая схема
ПЛК запускает считывание кодов. Соответствующие лестничные логические схемы 
показаны ниже.

	y Включение триггера (Enable Trigger)
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● 

Note 
● NoRead is enabled, Results OK + “NoRead” 

● 

Note 

Ladder Diagram 

● 

Figure 4-8 Enable Trigger 
● 

Figure 4-9 Send Trigger Signal 
● 

Рис. 4-8 Включение с триггера (Enable Trigger)
	y Триггерование устройства для считывания кодов

Сигнал триггера может быть сформирован путем добавления фронтального сигнала 
перед Trigger Ready в соответствии с задачей. Например, когда ПЛК обнаруживает 
фотоэлектрический входной сигнал, сигнал триггера отправляется один раз.
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● 

Note 
● NoRead is enabled, Results OK + “NoRead” 

● 

Note 

Ladder Diagram 

● 

Figure 4-8 Enable Trigger 
● 

Figure 4-9 Send Trigger Signal 
● 

Рис. 4-9 Отправка сигнала триггера
	y Очистка сигнала триггера
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Figure 4-10 Clear Trigger Signal 
● 

 

Figure 4-11 Get Device Results 
● 

 
Figure 4-12 Clear Error 

View Results 

Рис. 4-10 Сброс сигнала триггера
	y Получение результатов с устройства

Когда устройство выдает сигнал Results OK или NG, это означает, что данные результата 
были обновлены, и ПЛК считывает данные результата в блок данных базы данных.
После завершения считывания задается сигнал Results Ack, подтверждающий, что устройство 
завершило считывание данных результата.
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Figure 4-10 Clear Trigger Signal 
● 

 

Figure 4-11 Get Device Results 
● 

 
Figure 4-12 Clear Error 

View Results 

Рис. 4-11 Получение результатов с устройства
	y Clear Error

Когда возникает ошибка триггера и результат не выводится, устанавливается сигнал General 
Fault. После определения причины ошибки можно настроить сигнал Clear Error на устранение 
ошибки, и устройство продолжит получать изображения.

62 

Figure 4-10 Clear Trigger Signal 
● 

 

Figure 4-11 Get Device Results 
● 

 
Figure 4-12 Clear Error 

View Results 

Рис. 4-12 Устранение ошибки

Просмотр результатов
Вы можете отслеживать состояние каждой переменной модуля устройства и просматривать 
выводимые результаты с помощью программного компонента/буферизованной памяти. Вы 
также можете наблюдать за изменением последовательности сигналов модуля устройства 
с помощью отслеживания выборок.
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Глава 5   FINS

5.1	 Введение
Коммуникационный протокол FINS (Factory Interface Network Service) - это система команд/
ответов для сетей управления промышленной автоматизацией, разработанная Omron. Она 
помогает обеспечить бесперебойную связь между различными сетями.

 Примечание
В этой главе на примере ПЛК серии Omron NX объясняется, как взаимодействовать с 
интеллектуальным считывателем кода с помощью коммуникационного протокола FINS. 
В отношении других устройств следует руководствоваться инструкциями пользователя, 
предоставляемыми производителем, и выполнять соответствующие настройки на основе 
информации, содержащейся в этой главе.	

5.2	 Подключение оборудования
Схема подключения ПЛК серии Omron NX и интеллектуального считывателя кода показана 
ниже.
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Chapter 5 FINS 

5.1 Introduction

Note 

5.2 Hardware Wiring

Omron NX Series PLC Industrial Switch

Smart Code Reader

Figure 5-1 Hardware Wiring 

5.3 Smart Code Reader Settings
code reader’s FINS 

ПЛК серии Omron NX Промышленный коммутатор

Интеллектуальный 
считыватель кода

Рис. 5-1 Подключение оборудования

5.3	 Настройки интеллектуального считывателя кода
Прежде чем использовать функцию FINS интеллектуального считывателя кода для 
взаимодействия с устройствами ПЛК, необходимо настроить интеллектуальный считыватель 
кода с помощью программного обеспечения IDMVS.
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Прежде чем приступить к настройке:
	y Убедитесь, что на вашем компьютере установлено программное обеспечение IDMVS 

версии V2.3.1 или выше.
	y Проверьте версию прошивки устройства.

Последовательность действий
1.	 Двойным щелчком мыши выберите устройство в списке устройств для его подключения 

к ПО.
2.	 В окне просмотра в режиме реального времени выберите режим работы устройства 

Normal (Обычный).
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Before you start: 
● 

● Check the device’s firmwa

Steps  

Normal

Figure 5-2 Set Device Mode 
Communication Settings
FINS FINS Enable

FINS Server IP FINS Server Port
FINS Control Poll Interval 

Note 

Рис. 5-2 Настройка режима работы устройства
3.	 Перейдите в Communication Settings (Настройки связи) на левой панели навигации.
4.	 Выберите FINS в качестве протокола связи и включите FINS Enable.
5.	 Введите IP-адрес сервера FINS и порт сервера FINS в соответствии с задачей.
6.	 Установите интервал FINS Control Poll Interval в соответствии с сервера FINS.

 Примечание
Модули управления, состояния и результатов расположены в области DM устройства. Адрес 
смещения и размер результирующего модуля можно конфигурировать.
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Figure 5-3 Set Parameters 
Data Processing 

Figure 5-4 Set Data Processing 

Рис. 5-3 Установка параметров
7.	 Перейдите в раздел Data Processing (Обработка данных) на левой панели навигации и 

задайте формат и содержимое выводимой информации.
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Figure 5-3 Set Parameters 
Data Processing 

Figure 5-4 Set Data Processing Рис. 5-4 Настройка обработки данных
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 Примечание
	y Подробные настройки обработки данных приведены в руководстве пользователя 

интеллектуального считывателя кода.
	y Конкретные параметры могут различаться в зависимости от модели устройства.

5.4	 Настройки ПЛК
В этом разделе в качестве примера настройки приводится ПЛК Omron NJ102-9000.

 Примечание
Обмен данными по рпотоколу FINS поддерживает только порт 2 ПЛК Omron NJ102-9000, 
поэтому убедитесь, что порт 2 находится в том же сегменте сети, что и устройство. При этом 
Sysmac Studio настраивает ПЛК через порт 1, поэтому убедитесь, что порт 1 находится в том 
же сегменте сети, что и ПК.

Последовательность действий
1.	 Запустите Sysmac Studio, выберите New Project (Создать проект), введите параметры и 

нажмите Create (Создать).
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Note 
● 
● 

5.4 PLC Settings

Note 

Steps  
New Project Create

Figure 5-5 Create New Project 
 Configurations and Setup → Controller Setup → Built-in Ethernet/IP Port 

Settings

Note 
● The configured IP address of PLC’s port 1 should be in the same network segment with 

● address of PLC’s port 2 should be in the same network segment with 
the device’s IP address.

Рис. 5-5 Создание нового проекта
2.	 Перейдите в Configurations and Setup → Controller Setup → Built-in Ethernet/IP Port Settings 

и установите IP-адрес порта 1 и порта 2 ПЛК через настройки TCP/IP.

 Примечание
	y Установленный IP-адрес порта 1 ПЛК должен находиться в том же сегменте сети, что и 

ПК.
	y Установленный IP-адрес порта 2 ПЛК должен находиться в том же сегменте сети, что и 

IP-адрес устройства.
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Figure 5-6 Set IP Address

Figure 5-7 Configure Port and Connection Settings 

Figure 5-8 Create Global Variables 

Рис. 5-6 Установка IP-адреса
3.	 Введите порт FINS/TCP и настройте параметры подключения FINS/TCP.
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Figure 5-6 Set IP Address

Figure 5-7 Configure Port and Connection Settings 

Figure 5-8 Create Global Variables 

Рис. 5-7 Настройка параметров порта и подключения
4.	 Создайте глобальные переменные для передачи данных по FINS.
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Figure 5-6 Set IP Address

Figure 5-7 Configure Port and Connection Settings 

Figure 5-8 Create Global Variables Рис. 5-8 Создание глобальных переменных
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5.	 Включите область DM, установив на ней флажок, как показано ниже, и выделите 
созданные глобальные переменные в память DM.
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Figure 5-9 Enable DM Area 

Controller → Online
Controller → Transfer… → Transfer to Control…

5.5 Device Storage Area Definition

Control 

● 
● 

Рис. 5-9 Включение области DM
6.	 Сохраните настройки, перейдите в Controller → Online и подключитесь к ПЛК.
7.	 Перейдите в Controller → Transfer… → Transfer to Control… и запишите конфигурацию в 

ПЛК.

5.5	 Определение области хранения устройства
Связь FINS использует только область хранения DM, которая состоит из трех областей: 
управление, состояние и результат.

Управление
Область управления управляет устройством для передачи изображений с ПЛК на устройство.

	y Расположение области управления: область хранения DM, настраиваемое смещение (по 
умолчанию 0).

	y Размер области управления: 2 байта.
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Таблица 5-1 Определение области управления

D0/
бит Название Описание

D0.0 Trigger Enable С помощью этого бита ПЛК управляет функцией включения 
устройства по триггеру

D0.1 Триггер При выполнении следующих условий ПЛК устанавливает 
этот бит для запуска устройства для получения изображения 
и однократного запуска алгоритма.

	y Задано Trigger Enable.
	y В настоящее время устройство не получает изображения 

и не запускает алгоритмы.
	y Задано Trigger Ready.

D0.2 Results Ack 
(Подтверждение 
результатов)

После того, как ПЛК получит последние результаты, 
задается Result Ack. При этом Results OK и Results NG будут 
стерты.

D0.3-
14

Reserved Зарезервировано.

D0.15 Clear Error Состояние устранения ошибки.

Состояние
Область состояния возвращает текущее состояние устройства с устройства на ПЛК.

	y Расположение области состояния: область хранения DM, настраиваемое смещение  
(по умолчанию 1).

	y Размер области состояния: 2 байта.
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Таблица 5-2 Определение области состояния

D1/бит Название Описание
D1.0 Trigger Ready Устройство готово к приему нового триггерного сигнала.

Когда задан параметр Trigger Enable и устройство готово 
к приему следующего сигнала триггера, устанавливается 
состояние готовности к триггерованию (Trigger Ready).

D1.1 Trigger Ack Устройство уже получило сигнал триггера.

D1.2 Acquiring Устройство получает изображения.

D1.3 Decoding Устройство распознает расшифровки по изображениям.

D1.4-7 Reserved Зарезервировано.

D1.8 Results OK Устройство успешно выдает новые результаты.
Когда на ПЛК задано Results Ack, он будет очищен.

D1.9 Results NG Устройство не считывает коды и не выводит результаты.
Когда на ПЛК задано Results Ack, он будет очищен.

 Примечание
Отключите функцию NoRead при использовании сигнала NG.

D1.10-14 Reserved Зарезервировано.

D1.15 General Fault Внутренняя неисправность устройства. Этот сигнал можно 
устранить с помощью команды Clear Error (Устранить ошибку).

Результат
В области результатов хранятся данные о результатах, передаваемые с устройства на ПЛК.

	y Расположение области результатов: область хранения DM, настраиваемое смещение (по 
умолчанию 2).

	y Размер области результата: от 4 до 500 регистров (по умолчанию 100).
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Таблица 5-3 Определение области результата

DM/Слово Название Описание
D2 Результат

Длина
Область результатов содержит недопустимую длину данных.

D3... Данные 
результата

Результат, выданный устройством.
	y Если	 длина данных результата меньше, чем 

сконфигурированный модуль результатов, свободные 
байты будут заполнены значением 0.

	y Если	 длина данных результата больше, чем 
сконфигурированный модуль результатов, лишние байты 
будут обрезаны.

5.6	 Триггер-тест

Схема последовательности передачи данных
Схема последовательности передачи данных между ПЛК и устройством показана ниже.
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Table 5-3 Result Area Definition 

DM/Word Name Description 

D3…
● 

● 

5.6 Trigger Test

Communication Sequence Diagram 

Figure 5-10 Communication Sequence Diagram 

2. After detecting the device’s Trigger Ready signal, the PLC sends Trigger signal D0.1 and 

● 

Рис. 5-10 Схема последовательности передачи данных
Логика приведенной выше схемы последовательности передачи данных показана ниже:
1.	 ПЛК устанавливает сигнал Trigger Enable D0.0. После того, как устройство будет готово, 

задается сигнал Trigger Ready D1.0.
2.	 После обнаружения сигнала устройства Trigger Ready ПЛК посылает сигнал триггера D0.1 

и управляет устройством для считывания кодов.
3.	 Устройство начинает получать изображения и расшифровывать их после получения 

сигнала триггера.
	y Если коды считаны успешно, задается сигнал Results OK D1.8 и вводится длина кода и его 

содержимое в адрес, начинающийся с D2.
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	y Если считывание кодов не удалось, задается сигнал Results NG D1.9 и очищается 
начальный адрес D2.

 Примечание
	y Если при включенном NoRead коды не считываются успешно, возвращается значение 

Results OK + символ NoRead.
	y Если коды не считываются успешно, когда NoRead отключен, возвращается значение 

Results NG.

4.	 После обнаружения Results OK/NG ПЛК начинает считывать длину кода и данные из D2.
5.	 После завершения считывания результатов подается сигнал подтверждения результатов 

Results Ack D0.2, и на устройство поступает уведомление.
6.	 После завершения процесса триггера ПЛК снова посылает сигнал триггера, и начинается 

следующий цикл процесса триггера.

 Примечание
Если после получения сигнала триггера интеллектуальный считыватель кода не может 
вывести результаты из-за внутренней ошибки (например, после подключения считывателя 
кода к IDMVS не включается получение изображений), будет подан сигнал General Fault 
D1.15. После того, как ПЛК подтвердит причину ошибки, подается сигнал Clear Error D0.15, и 
операция запуска может быть продолжена после устранения ошибки.

Создание переменных
Создайте переменную, как показано ниже, в соответствии с определением области хранения 
устройства.
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● 

Note 
● If codes are not read successfully when NoRead is enabled, Results OK + “NoRead” 

● 

Note 

Create Variables 
the device’s storage area definition.

 
Figure 5-11 Create Variables 

Ladder Diagram 

● 

Рис. 5-11 Создание переменных

Лестничная логическая схема
ПЛК запускает считывание кодов. Соответствующие лестничные логические схемы 
показаны ниже.

	y Включение триггера (Enable Trigger)
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Figure 5-12 Enable Trigger 
● 

Figure 5-13 Send Trigger Signal 
● 

Figure 5-14 Clear Trigger Signal 
● 

Note 

 

Figure 5-15 Get Device Results 
● 

Рис. 5-12 Включение триггера (Enable Trigger)
	y Триггерование устройства для считывания кодов

Сигнал триггера может быть сформирован путем добавления фронтального сигнала 
перед Trigger Ready в соответствии с задачей. Например, когда ПЛК обнаруживает 
фотоэлектрический входной сигнал, сигнал триггера отправляется один раз.
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Figure 5-12 Enable Trigger 
● 

Figure 5-13 Send Trigger Signal 
● 

Figure 5-14 Clear Trigger Signal 
● 

Note 

 

Figure 5-15 Get Device Results 
● 

Рис. 5-13 Отправка сигнала триггера
	y Очистка сигнала триггера
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Figure 5-12 Enable Trigger 
● 

Figure 5-13 Send Trigger Signal 
● 

Figure 5-14 Clear Trigger Signal 
● 

Note 

 

Figure 5-15 Get Device Results 
● 

Рис. 5-14 Сброс сигнала триггера
	y Получение результатов с устройства

Когда устройство выдает сигнал Results OK или NG, это означает, что данные результата 
были обновлены, и ПЛК считывает данные результата в блок данных базы данных.
После завершения считывания задается сигнал Results Ack, подтверждающий, что устройство 
завершило считывание данных результата.

 Примечание
Если порядок байтов считанных кодов отличается от фактического, можно включить 
функцию перестановки байтов результатов в программе IDMVS.
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Figure 5-12 Enable Trigger 
● 

Figure 5-13 Send Trigger Signal 
● 

Figure 5-14 Clear Trigger Signal 
● 

Note 

 

Figure 5-15 Get Device Results 
● 

Рис. 5-15 Получение результатов с устройства
	y Clear Error
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Figure 5-16 Clear Error 

View Results 

Figure 5-17 View Results 

 

 

 

 

Рис. 5-16 Clear Error

Просмотр результатов
Вы можете отслеживать состояние каждой переменной модуля устройства и просматривать 
выводимые результаты в окне монитора.
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Figure 5-16 Clear Error 

View Results 

Figure 5-17 View Results 

 

 

 

 

Рис. 5-17 Просмотр результатов
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